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LIGHTROOM 4: STREAMLINING YOUR DIGITAL PHOTOGRAPHY PROCESS

GETTING STARTED: Foundations for Success

WELCOME TO LIGHTROOM 4
Adobe Photoshop Lightroom is a full-
featured software program for digital 
image management and processing, 
designed for professional and serious 
amateur photographers alike. As the 
offi  cial Adobe press release explains, 
Lightroom enables photographers to 
“import, manage, enhance and showcase” 
all their photos and videos. Lightroom 4.0 
is a major upgrade and is recommended 
for all previous users as well as those just 
getting started with Lightroom.

Lightroom’s integrated approach to 
handling the entire digital photography 
workfl ow off ers photographers signifi cant 
advantages over other individual programs. 
However, if you also want to use other software, 
Lightroom also integrates very well with other 
programs—you can use Lightroom as the hub of 
your image processing system and easily jump 
over to other software (including Photoshop) to 
perform specialized tasks as needed. That said, 
once you’ve mastered Lightroom, you may fi nd 
you rarely—if ever—need to use other software 
to process the vast majority of your photos.

In this chapter I’ll introduce core Lightroom 
concepts and explain the screen interface. 
If you’re new to Lightroom, I strongly 
recommend you read this chapter before 
proceeding through the remainder of the 
book as you’ll fi nd learning Lightroom much 
easier with the fundamentals described in the 
following sections. (If you’re an experienced 
Lightroom user, you may be able to skip most 
of this and go straight to other chapters.)

Internet access required for some features
Lightroom 4.0 is more dependent on the Web 
than were previous versions. In particular, the 
Map module depends on Internet access for core functionality (it pulls map data from 
Google). Also, to upload books from the new Books module you’ll need to be online.

Major changes to minimum 
system requirements

Process Version 2012 and 
related controls

Play, edit and develop videos
Books module
Map module
Improvements to local 

adjustments
Soft Proofi ng and related 

updates in the Print module
New methods for saving your 

work in output modules
Email photos from Lightroom
Updates to Publish Services
Raw format support for new 

cameras
Improved Lens Corrections and 

new lens profi les 
Feature support for the new DNG

1.4 spec
More consistency throughout 

the user interface

What’s New in Lightroom 4
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01Language support
Lightroom 4 is available with support for many languages (the Read Me fi le contains 
more information about this). If you use a Mac and want to choose a diff erent language, 
you can now do so with a new control in the Preferences panel.

What’s NOT in Lightroom 4.0
Inevitably, there will always be features some folks want that didn’t make the fi nal list. In 
an eff ort to answer your questions right up front, here’s a short list of some of the things 
people typically clamor for but are not in Lightroom 4.0:

• Non-circular cloning and healing (like Photoshop)

• Face recognition

• Layers

• Import from Aperture and iPhoto

• Support for 3D video

Lightroom and Adobe Photoshop Camera Raw
Many photographers use Lightroom in conjunction with the full version of Photoshop 
and the Adobe Camera Raw plug-in. For full compatibility you’ll need to maintain 
the latest versions of all software and be sure that XMP metadata is saved after editing 
in each program. The Read Me that comes with the Lightroom 4 installer has more 
information on compatibility between the software versions. See Chapter 5 for more 
about using Lightroom with Photoshop.

Lightroom and PSE
If you want to do more with your photos that what Lightroom can directly provide, it’s hard 
to beat the combination of Lightroom and Photoshop Elements (PSE). PSE off ers the most 
essential functionality of the full version of Photoshop at a very low price, and with both 
programs installed on your computer you’ll have an enormous range of capabilities.

How to use this book
This book is not meant to be read as much as it is meant to be used, presumably while at 
your computer with Lightroom 4 running. Of course, you can learn about some features 
by reading about them, but in most cases you’ll learn the fastest when you follow along 
on your computer as you read the steps and descriptions. Also, due to inherent space 
limitations, some of the screenshots used for the illustrative fi gures are small—you’ll fi nd 
it easier to learn if you’re looking at Lightroom full-size on your own computer display.

PREREQUISITES
The content of this book assumes you have at least basic- to intermediate-level 
computer skills, are comfortable managing fi les on hard drives and removable media, 
and understand common computer operations such as copy/paste and manipulating 
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dialog boxes. (If you’re just learning to use a computer, Lightroom is probably not your 
best choice of software.) I also assume you have a fundamental working knowledge of 
your camera.

CHAPTER STRUCTURE
The chapters in this book are segmented by module and key features and are generally 
sequenced in the order you might use Lightroom. In particular, the fi rst few chapters—
Import, Library, Develop and Export—are presented in the order you’ll approach your 
photo processing workfl ow. The content pertaining to the output modules—Book, 
Slideshow, Print and Web—will be useful on an as-needed basis; there’s no specifi c order 
in which you’d use these modules. The new Map module, which won’t be for everyone, 
is sandwiched in between the other modules. The last chapter, covering the advanced 
use of Lightroom catalogs, will come in handy when you’ve gained a basic working 
knowledge of Lightroom, and especially when you are ready to take your workfl ow to 
the next level by using multiple catalogs. The Appendix contains additional information, 
mainly for advanced users, and is intended to address specialized questions and topics 
not everybody will be concerned with. The Appendix also contains a list of my favorite 
shortcuts and links to helpful Web sites as well as a glossary of terms.

Each chapter starts with an overview of what will be covered, and then a basic, suggested 
workfl ow is presented using a step-by-step approach. These workfl ows are mainly 
included to give you an idea of the typical tasks involved; after reading the rest of the 
chapter you’ll no doubt begin developing and refi ning your own workfl ows. Following 
the introductory workfl ow, each module, window, panel and control is explained in detail, 
based on the general order of how the screen interface is presented. The chapters all fi nish 
with suggestions for next steps and things to consider for maximizing your eff ectiveness 
using Lightroom. Throughout the chapters I’ve also sprinkled in my own comments and 
opinions; take them as you will.

Finding what you’re looking for
Because of the way each chapter is structured, you can easily look up general topics using 
the Table of Contents, and the opening page of each chapter also lists the main topics 
included in that part of the book. In certain cases, looking up a topic in the Index will give 
you a better overview of how and where that topic is addressed.

There is a fair amount of intentional repetition to solidify key concepts. Also, you will note 
that because some features are shared by multiple modules (such as the color picker) 
I’ve chosen to elaborate on the functionality in one chapter, and then refer back to that 
on the relevant pages in other chapters. My hope is that you won’t have to jump around 
too much, but even though working with Lightroom can be done in a fairly linear way, 
explaining the tools can’t be done this way because of the amount of overlap between 
some of the module controls.

If you’re new to Lightroom you will benefi t from working through this book in a linear 
fashion. Although the material is mostly presented in sequence based on workfl ow, it may 
also be helpful to jump from one topic to another as needs dictate. You can use this book 
to learn Lightroom from the ground up, or refer back to something later. When you have a 
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01basic familiarity with the software and workfl ow, you can later refresh your knowledge 
by going straight to the section or page containing the shortcuts, tips and techniques 
appropriate for the task at hand. Before long, you’ll know Lightroom inside and out—
and that’s when the real fun begins!

Get the book spiral bound
It would be wonderful if we could release this book in spiral-bound form, but it’s not 
logistically feasible with a publication such as this. Instead, I highly recommend you take 
this book to your nearest copy shop or offi  ce supply store to have them chop the spine 
off  and put on a plastic coil binding. This allows the opened book to lay fl at on your 
computer desk while you’re working through the material. If you plan to use the book 
frequently, you might also add a durable, clear plastic cover.

ICONS
Throughout the book, I’ve placed small tidbits of additional information for your 
consideration. Although these are separate from the literal descriptions of Lightroom’s 
essential functionality, they are derived from my own experiences with Lightroom, my 
work with countless clients and students, and extensive, ongoing research into best 
practices in Lightroom and digital photography in general. I’ve done my best to put 
these icons in context with the steps in the workfl ow where they are most relevant. 
They are denoted by small graphic elements and colored text, as described below:

New in Lightroom 4: Throughout the book I’ve highlighted in bold the main features 
new to this release of Lightroom.

Tip
These off er common “best practices” in digital photography and imaging, ways to speed 
up your workfl ow, methods of processing and suggested ways to approach various 
tasks. Though some Tips are more important than others, they are all suggested reading.

Reminder
Reminders are generally Tips found in multiple places in the book.

Preference
I’ve noted important Lightroom Preferences near the descriptions of the controls they 
aff ect. As the name implies, a Preference comes down to your personal choice; in most 
cases I explain my own way of working in order to create a framework for your own 
decision making.

Warning
Warnings are strong cautions against doing something a certain way, or explanations of 
potentially tricky aspects to watch out for.

Shortcuts: Mac and Windows
Lightroom is full of keyboard shortcuts and I’ve tried to include those that I think you’ll 
fi nd most useful. I strongly recommend you try to memorize and use the most common 
shortcuts—using the keyboard to work in Lightroom can eliminate many manual steps 
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and makes performing tasks much faster. The Mac shortcut is listed fi rst, followed
by the Windows shortcut. 

The shortcuts in this book are based on Lightroom 4, though most of them also work in 
earlier versions, and most will continue to work in future versions. Some of these shortcuts 
are not included in Lightroom Help or other offi  cial documentation. This increases the 
possibility they may change from one version release to another. In a printed book, I can’t 
guarantee that the accuracy of the published shortcuts will last forever. There’s a list of 
some of the most useful shortcuts at the end of the book.

Module shortcuts
Each module has a screen available listing the most commonly used shortcuts for 
that module. To view this screen, use the menu command at Help➔[Module Name] 
Shortcuts…or use the shortcut!

Lightroom Queen shortcuts lists
Victoria Bampton, aka The Lightroom Queen, maintains the most comprehensive and 
up-to-date lists of Lightroom shortcuts available. If you want to learn all the shortcuts for 
speeding up your workfl ow, you can’t do better than her lists. You can download them at 
www.lightroomqueen.com/keyboard-shortcuts.

Keyboard variations 
On Mac, the “Apple” key and  (Command, or cmd) are the same. On Windows, Control 
and Ctrl are the same. (In some cases, the Control key is also used on Mac.) Option on
Mac is the same as Alt on Windows.

Workfl ows
Each chapter contains one or more suggested workfl ows, presented step-by step.

What is a “workfl ow” and why should I care?
The term workfl ow simply describes a sequence of steps to produce a specifi c result. 
Understand that there is no single workfl ow that will be “right” for everyone. The workfl ows 
I’ve included are meant to be fast, simple and straightforward. By necessity, this means 
that at times I’ve left something out because it is too complex to address in the context of 
the steps. Over time, you will create your own workfl ows based on the tasks you need to 
accomplish with your photography.

Example Lightroom workfl ow
To give some context to the detailed explanations that follow in this chapter, following
is an overview of a typical Lightroom workfl ow:

Step 1. Capture digital photos.

Step 2. Copy photos to a hard drive and import them to a Lightroom catalog.

Step 3. Organize photos in the Library module.

+/ or
Ctrl+/
Selected
module
shortcuts
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01Step 4. Back up your photos and catalog.

Step 5. (Optional) Plot photo locations in the Map module.

Step 6. Enhance and optimize photos in the Develop module.

Step 7. Export fi nished photos for specifi c purposes.

Step 8. (Optional) Create Books, Slideshows, Prints and Web Galleries.

Step 9. Update your backups!

Of course, each of these steps is actually comprised of multiple tasks, the specifi cs of 
which will vary depending on circumstances. These tasks—and time saving shortcuts and 
techniques—are explained in detail in the following chapters. If you perform each phase 
of the workfl ow similarly every time, you will soon be able to think several steps ahead. This 
facilitates better decision-making, dramatically speeds up your work and ultimately allows 
the highest possible quality for your photographic work.

GETTING MORE HELP
Situations may arise for which you need more help than what’s provided in this book. Adobe 
can be a good place to start, but there is a vast number of other resources run by Lightroom 
enthusiasts (and most of them free) available online. I’ve included a comprehensive list of 
links in the Appendix.

Built-in Lightroom Help
From within Lightroom, you can access Adobe’s online help system, which is quite 
thorough on many topics. It’s in the same place on Mac and Windows, under the Help 
menu➔Lightroom Help (F1). (Requires Internet access.)

Lightroom in the social media
You’ll fi nd all kinds of useful Lightroom resources on Facebook, Twitter and YouTube. These 
sites are also good places to ask questions. There are also many online forums where people 
discuss Lightroom, share tips and tricks and help solve problems. See the Appendix for links.

Confi guring your computer for Lightroom 4
Before you install Lightroom you should be sure your computer is up to snuff . Lightroom 
is a powerful application, and as such can sometimes be quite demanding on computer 
resources. Most importantly, make sure your computer meets the minimum system 
requirements, which have changed signifi cantly in version 4.0.

In all but a couple of very minor ways, working with Lightroom is essentially the same on 
Mac and Windows. Some of the menu commands are in diff erent places, and there are some 
diff erences in the way that Lightroom works with the fi le systems on diff erent operating 
systems. But all-in-all, you should expect a great experience with Lightroom regardless of 
your operating system.

F1
Help

+Option+/
or Ctrl+Alt+/
Current
module Help
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LIGHTROOM 4 SYSTEM REQUIREMENTS
Below are listed the current minimum requirements for Lightroom 4.0. If your computer 
doesn’t meet or exceed these, you won’t be able to install the program.

Windows
• Processor: Intel Pentium 4 or AMD Athlon 64

• OS: Microsoft Windows 7 with Service Pack 1, Windows Vista Home Premium, 
Business, Ultimate, or Enterprise with Service Pack 2

• RAM: 2 GB

• Hard Disk: 1 GB of available hard-disk space

• Media: DVD-ROM drive

• Display: 1024 x 768 Monitor Resolution

Macintosh 
• Processor: Multicore Intel processor with 64-bit support

• OS: Mac OS X 10.6.8 (Snow Leopard) or MAC OS X 10.7 (Lion)

• RAM: 2 GB

• Hard Disk: 1 GB of available hard-disk space

• Media: DVD-ROM drive

• Display: 1024 x 768 Monitor Resolution

NOTE: on all systems, an active Internet connection is required for Web-based
services (Map module, uploading Books, etc.)

Help➔System Info
Once Lightroom is installed and running correctly, you can see a summary of
your system info using this command under the Help menu.

RECOMMENDED COMPUTER SETUPS
As you might expect, the minimum system requirements are usually far from the ideal 
setup. And as a digital photographer, you owe it to yourself to work with the most 
capable tools you can aff ord—your computer is no exception. You’ve probably spent 
lots of money on your camera gear; why skimp on your digital darkroom? What follows 
here is a summary of my recommendations for setting up your computer as a photo 
processing workstation. The Appendix also includes a section on optimizing Lightroom’s 
performance.
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01RAM (aka memory)
As noted in the minimum specs, Lightroom can technically run with 2 GB RAM, but 
honestly, you won’t have a pleasant experience working with this limited amount of 
memory. 4GB is really the practical minimum, and if you can bump this up to 8 GB or 
more you’ll see a huge diff erence in speed and stability.

Computer displays
You will have the most success processing your photos if you use a good quality 
display. The diff erences in quality and accuracy between monitor makes and models 
can be signifi cant. Generally speaking, I think you can expect to spend a minimum 
of USD $500 or the equivalent for a monitor suitable for photography work. I highly 
recommend displays from NEC and Eizo; with the range of products available from these 
two companies there’s really no need to consider other brands. (I currently use—and 
absolutely love!—the NEC MultiSync PA241W, which is reasonably priced and has a very 
wide gamut output.) Also of critical importance is calibrating and profi ling your display; 
see the section on color management later in this chapter.

Using Lightroom with dual monitors
Lightroom provides support for a Secondary Display; this is an additional window 
containing a diff erent set of controls from the main application display window. The 
most common use for the Secondary Display is showing a large preview while the main 
window shows smaller previews. Using the Secondary Display is the only practical way 
to utilize a second window in Lightroom, and is discussed further later in this chapter 
and in Chapter 3.

Hard drives (aka storage)
It’s important that you plan out your photo storage system carefully, accounting for 
your current needs and budget along with a plan for growth. Over the coming years 
your photo library may grow to hundreds of thousands—or even millions—of images! 
If you’re not already using a good organizational system, now is the time to start.

At this point, magnetic and solid state (SSD) hard drives are the most practical options for 
storing your photo library. Magnetic hard drives are inexpensive and the capacities of 
the most common drive sizes (500GB, 1TB, 2TB) will be enough for most people, at least 
for now. (The prices for SSD drives are coming down, but with relatively limited capacities 
and higher costs they are still impractical for most digital photography storage systems.)

In addition to the recording format, the other main choice in hard drive systems is 
whether to use single drives or RAID units. RAID storage uses multiple disks that appear 
to your system as a single volume. RAID systems can also be confi gured to automatically 
copy fi les between the disks in the system to provide transparent backup capability. 

Use dedicated disk drives for your image library
Regardless of the drive format you choose, it’s best to not store your image fi les on your 
system disk. (The system disk is the hard drive that contains your operating system, and 
usually also contains your applications and other programs.) I strongly recommend you 
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store your photo library on disk drives used only for that purpose. If you currently are storing 
your photos on the system disk (such as in the default Pictures folder), I recommend you set 
up new drives to use only for your imaging work. 

External drives provide the most fl exibility—they are highly portable and can be moved to 
another computer as needed. External USB, FireWire (IEEE 1394) and Thunderbolt interfaces 
usually provide adequate read/write times when using Lightroom. (I currently use 2TB single 
drive external units.) 

It’s easiest to use fewer, larger disk for your entire image library: one or two large-capacity 
disks are much easier to manage than many small ones. More importantly, a single master 
hard drive also facilitates easier backups. As your library grows and your disks fi ll to capacity, I 
recommend you simply transfer your photo library to progressively larger drives.

When I’m buying new hard drives, I buy enough storage capacity to grow into for at least the next 
18 months. I always buy drives in pairs (at minimum and, ideally, in triplicate). One is the master 
working drive, on which are stored all my original working fi les. The second drive is the working 
backup, which is updated after every work session. The third drive is an archive, updated less 
frequently than the working backup and stored off -site. When considering brands, I prefer to stick 
with those that are well-known for reliability; I’ve had great experiences with Seagate and Western 
Digital. (Interestingly, when I’ve had drives fail, they always seem to be Hitachi or Toshiba.)

About asset management
Asset management is all about how you name, organize, store, and back up your image fi les. 
Asset management plays a crucial role in your ability to fi nd, work with, and share your photos. 
For most photographers this is certainly not the most fun or exciting part of the process, but it’s 
not optional—if nothing else, the sheer volume of digital photographs you make requires you to 
develop and implement a comprehensive system for managing your images.

Organizing and naming your image fi les
At one point or another one of the most daunting challenges all photographers face is deciding 
how to arrange their image fi les into folders and what to name fi les and folders. The most 
important thing is to create a standardized system and use it consistently. What’s most important 
is that you create a good plan that you can start using now. You can later decide whether you 
need to go back and rework your old image archives to conform to the new system.

There are lots of diff ering opinions about how image fi les should be named and organized; 
this is an area where your personal preferences play a signifi cant role in your decisions. In 
the end, the system has to make sense and work for you. It doesn’t make sense to adopt 
someone else’s strategy if it only causes you confusion and the risk of misplacing or losing 
fi les. That said, there are some widely accepted best practices for how to organize and name 
your fi les and folders:

• Every fi le and folder in your image library must have a unique name.

• Give fi les and folders meaningful names. The fi lenames assigned by your camera are 
useless in a structured storage system.
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01• In your names, include a formatted date, such as YYMMDD.

• Also include some kind of identifi er as to what the folder/fi le contains.
For the nature photographer, using the names of locations and/or subject
matter makes sense.

• Use sequence numbers (or “serial” numbers) to diff erentiate fi les from a single 
shooting session.

• Name and group folders and subfolders according to their date or content.

• When possible, give your folders and the fi les they contain the same base fi lename.

• The system must be able to scale (grow exponentially) over time.

You can learn more about using Lightroom for asset management in Chapters 2 and 3.

Installing Lightroom 4
There are two ways to install Lightroom: from a DVD or a downloaded package. Whether 
you’re using a Mac or Windows machine, the installation process and end results are 
essentially the same. Following are overviews of the installation processes, along with some 
things you should know when starting out. Installing Lightroom is not complicated; you will 
probably be able to fi nish the installation using only the on-screen instructions provided by 
the installer. (Complete installation instructions are provided in the Read Me fi le that comes 
with the Lightroom installer package.) If you are unable to install Lightroom, you will need to 
consult Adobe’s documentation and/or technical support.

Download installers
Any software application that comes on a DVD has a limited shelf life; Lightroom 4.0 is no 
exception. If you’ve purchased Lightroom 4 as a DVD, I suggest that in the future you’ll 
be much better off  downloading the updates from the Adobe.com Web site. Provided 
there’s a fast enough Internet connection available, it’s almost always best to download 
installers from the manufacturer’s Web site, mainly because you’re assured of receiving 
the most current version.

Antivirus software issues
It’s been reported that Norton Antivirus and MacAfee may incorrectly identify 
Lightroom fi les as potential threats. If you use these software packages, check their 
settings and be sure to allow access to the Lightroom catalog and other fi les.

Installing on multiple computers
Your license for Lightroom 4 allows you to install the application on up to two 
computers using the same serial number. (This can include diff erent operating systems; 
I have one installation running on a Mac Mini and one on a Windows laptop from Dell. 
You’ll need to use diff erent installer packages, but the serial numbers are platform-
independent so you can use the same number for both installations.)
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About Reverse Geocoding
In Lightroom 4, the fi rst time you open a new or upgraded catalog, you’ll see a message 
asking if it’s OK to enable reverse geocoding (see Figure 1–2). This is a privacy setting and is 
used for the new Map module—it’s entirely optional. If you choose to enable it right away, 
the feature will 
be active the fi rst 
time you switch 
the Map module. 
You can enable or 
disable Reverse 
Geocoding at any 
time using the 
Catalog Settings 
dialog box. Reverse 
Geocoding and 
Catalog Settings 
are discussed in 
detail in Chapters 6 
and 11.

INSTALLING LIGHTROOM FOR THE FIRST TIME
When you install Lightroom for the fi rst time using the default settings, the Lightroom 
program is placed in your Applications folder on your system drive and the Lightroom 
confi guration fi les (presets, templates, etc.) are placed in another directory, depending on 
your operating system. Also, Lightroom uses a database fi le, called a catalog, to manage 
your fi les and store the work you do on them.

New in Lightroom 4: the fi rst time you run Lightroom, if no previous catalogs are found, 
you will be prompted to enter a name and location for your default catalog (see Figure 
1–3). The default is your Pictures folder on the system drive; this is usually OK. Later, you 
might consider 
keeping your 
catalog on the 
same drive where 
all your photos 
are stored. (For 
an introduction 
to catalogs, see 
the section later 
in this chapter 
and for lots more, 
read Chapter 11.)

Figure 1-2

Figure 1-3
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Upgrading from previous versions of Lightroom can be signifi cantly more complicated 
than doing a fresh installation for the fi rst time. When you upgrade Lightroom, the 
new application itself is installed as if it was for the fi rst time; the previous version of 
Lightroom remains intact, so you’ll have both versions on your computer. Your custom 
preferences, presets and templates also remain untouched, but new Lightroom default 
presets may be added to the folders.

Before you jump right in to upgrading, there are a few important things to understand. 
First and most critical, every time you upgrade Lightroom to a “major release” (2.0. 3.0, 
4.0, etc.) you must also upgrade the catalog. (This can also sometimes apply to “minor 
releases” such as 2.3, etc.) You can upgrade a Lightroom catalog from any version to a 
newer version at any time.

What happens during a catalog upgrade
During the upgrade, your catalog from the old version is copied to a new fi le and the 
copied catalog is modifi ed to support Lightroom’s new features. No changes are ever 
made to the previous catalog! Your old catalog is still on your hard drive exactly like it 
was before the upgrade. (If you still have the earlier version of the Lightroom program 
on your computer, you can open the old catalog just like before.) If you’re not careful 
about this, you could end up working in several diff erent catalogs without knowing it. 
It’s also possible you might upgrade your old catalog multiple times, with each upgrade 
producing another copy of your old catalog. For these reasons, I strongly recommend 
that after you’ve successfully installed Lightroom 4, upgraded your catalog, and 
confi rmed everything looks like it’s running OK, you should uninstall the previous version 
of Lightroom and remove your old catalogs from your hard drives. (If this makes you 
nervous, just be sure to make backups fi rst.)

New in Lightroom 4: if you try to upgrade the same catalog more than once, 
Lightroom will let you know, and will show you the location of the previously
upgraded catalog.

How to upgrade a catalog
To upgrade your catalog, all you need to do is install the new version of Lightroom 
and launch the program. Lightroom 4 will fi nd your old catalog(s) and prompt you 
to upgrade (see Figure 1–4). In the upgrade window, be sure the correct catalog is 
selected for upgrading. By default, Lightroom will create the new catalog in the same 
folder as the original. If 
you’re using the default 
catalog name, Lightroom 
will automatically 
change the name of 
the new fi le to refl ect 
the current version. (For 
example, Lightroom 3 

Figure 1-4
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Catalog would become Lightroom 4 Catalog.) You can choose a diff erent location or fi le 
name by clicking the Change button. When you’re ready, click the Upgrade button to 
allow Lightroom to update the selected catalog.

Note: the default catalog set in Preferences in your older version of Lightroom will also 
become the default in Lightroom 4; you can always change this later.

Upgrade from Beta catalog
If you used the Beta version of Lightroom 4, you can upgrade that catalog to the full 4.0 
release version.

About old Lightroom plug-ins
Adobe doesn’t typically change anything in Lightroom’s program code that would 
inherently cause older plug-ins to fail, however, depending on the way those plug-ins 
were themselves coded, they may or may not work correctly in the new version.

MOVING LIGHTROOM TO A NEW COMPUTER
If you’re going to install Lightroom 4 on a new computer, fi rst copy your old catalog to 
that computer (or connect the external drive as described above). Then install Lightroom 
from scratch. When you open it for the fi rst time it will fi nd your old catalog and prompt 
you to upgrade. See Chapter 11 for lots more about working with catalogs.

REMOVING AND RE-INSTALLING LIGHTROOM
If something goes wrong during the installation, or if any time in the future you need 
to remove Lightroom, the process is fairly straightforward, but is diff erent on Mac and 
Windows machines. On Mac, you can usually just drag the Lightroom application to the 
Trash and then re-install. On Windows, in general, you should always use the Programs and 
Features Control Panel to uninstall Lightroom.

Note that it’s very rare for something to actually be wrong with the Lightroom program. If 
Lightroom isn’t running correctly it’s usually a problem with the catalog, not the program 
itself. In these situations, uninstalling and reinstalling won’t make any diff erence. Chapter 
11 off ers suggestions for troubleshooting catalogs.

MIGRATING TO LIGHTROOM FROM OTHER SOFTWARE
As newer versions of Lightroom have been released, they have increasingly been able 
to support migrating to Lightroom from other programs that use catalog architectures. 
Currently, you can upgrade from Photoshop Elements (PSE) to Lightroom. If you have PSE 
installed on your computer, the fi rst time you launch Lightroom you will be asked if you 
want to upgrade the PSE library. (In most cases, this will require that PSE is installed on the 
computer.) If you skip the upgrade during Lightroom launch, you can use the command 
under File➔Upgrade Photoshop Elements Catalog. (This command is not visible if you 
don’t have a PSE library and/or the program installed on the current machine.) Upgrading 
can also be adversely aff ected if the PSE library is not in the default location.
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01Quit PSE fi rst
When upgrading a PSE library, you should not have PSE running. Lightroom reads the PSE 
preferences and program data to identify library data it can upgrade.

It’s expected that future releases of Lightroom will also allow you to upgrade (and import 
from) image catalog fi les made using other programs. Stay tuned!

Lightroom Fundamentals
When the Lightroom application is running, it constantly pulls in data from a number of 
sources (see Figure 1–5). Lightroom’s main strengths are derived from the fact that it uses a 
database (the catalog) for most of its operations. Under the database model, all your edits to 
photos are totally 
non-destructive—the 
original pixel data 
in the fi les on disk is 
never modifi ed. Using 
catalogs also allows 
powerful search and 
fi ltering capabilities. 
Lightroom excels at 
batch processing; you 
can quickly and easily 
apply stored settings 
to many photos at 
once using presets, 
templates and sync 
operations. Also, 
within the catalog you 
can make unlimited 
virtual copies and 
collections of photos 
without needing to 
duplicate the original 
fi les on the hard drive.

Along with the 
organizational 
power of the catalog, 
Lightroom’s processing engine provides very high image quality. When the controls are used 
correctly, Adobe’s rendering of raw image data—as well as essential processing routines such 
as sharpening, noise reduction and making enlargements—are second to none.

Figure 1-5
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INTRODUCTION TO LIGHTROOM CATALOGS
Any time you’re working in Lightroom, you’re working within a catalog. A Lightroom catalog is 
a SQLite fi le with the extension .lrcat. When you launch Lightroom, it looks for a catalog to load. 
If you’ve never moved the default catalog, or haven’t created a new one, you will be working 
within the default catalog. However, you can make additional catalogs, and store them on any 
hard drive, even one that’s diff erent from where your image fi les reside. The name and location 
of catalog fi les have no direct eff ect on Lightroom’s operation, so you can name your catalog 
whatever you like, and put it on any local hard drive you choose. (Keeping your master catalog 
on the same external hard drive with the image fi les makes backups easier.) You can’t open a 
Lightroom catalog over a network.

Image fi les must be imported into a Lightroom catalog before you can work with them, 
during which Lightroom creates records of the photos within the catalog. (Importing 
photos is covered in Chapter 2.) It might help to think of a Lightroom catalog like a 
department store catalog: it contains all the information about the items but not the items 
themselves. It’s critical that you maintain the links between the Lightroom catalog and the 
actual fi les stored in folders on your hard disk.

Since a Lightroom catalog contains records of the photos and videos you’ve imported, 
but not the fi les themselves, all the work you do in the catalog is done by reference. As you 
work, Lightroom continually reads from each image fi le and/or video clip on the hard drive. 
Lightroom continually renders previews, which are also saved on the hard drive, in the folder 
next to the catalog fi le. The previews you see in Lightroom are generated using the current 
adjustment metadata. All this metadata is stored in the catalog, along with your history, 
collections, virtual copies, etc., and you can also save each photo’s adjustment metadata out to 
fi les on the hard disk. The original image data in your fi les are never modifi ed.

Working with catalogs is covered extensively in Chapter 11.

Essential fi le maintenance
If your catalog is lost, deleted or corrupted, the work you’ve done in the catalog may 
become inaccessible. This is why it’s imperative to: a) save your metadata to disk as you 
work, b) keep your catalog clean and optimized, and c) make regular backups of your 
catalog and image fi les.

Catalog corruption
If you don’t have a lot of experience using databases—especially for image editing and 
management—it may come as a shock if a problem with the Lightroom catalog makes 
your photos inaccessible. It is entirely possible that a Lightroom catalog could become 
corrupted and not be able to be opened or worked with in any way. In the vast majority 
of cases, a problem with the Lightroom catalog does not necessarily mean there’s 
a problem with the image fi les.
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Unlike Photoshop, which can open and save a dizzying array of image, graphic and 
video fi le formats, Lightroom is designed to work only with the most common formats 
generated by digital cameras and scanners. Lightroom can import, process and export 
the following types of fi les:

• Raw: raw captures from nearly all modern digital cameras (see notes below)

• DNG: Adobe Digital Negative

• JPEG (JPG): (Joint Photographic Experts Group) compressed image fi les

• TIFF (TIF): (Tagged Image File Format); 8 bit and 16 bit; may contain layers and 
vector elements

• PSD: 8 bit and 16 bit Photoshop documents (only those saved with the “Maximize 
Compatibility” option enabled)

• Video formats: digital movies from most popular cameras and smart phones 
including MOV, MPG, AVI and AVCHD (MTS and MT2S only)

Maximum dimensions
Lightroom can import image fi les up to 65,000 pixels per side or 512 megapixels. 
Files with dimensions that exceed this specifi cation will not be imported; you’ll 
receive a warning dialog containing a list of fi les that couldn’t be imported.

Files in CMYK mode
Lightroom can import fi les in CMYK color mode, but any Develop adjustments you 
apply to them will be done using Lightroom’s internal RGB color space. Lightroom 
cannot export fi les in the CMYK color space.

Raw format support
Raw fi les come from your camera with a format specifi ed by the camera manufacturer; 
common examples are Canon’s .CR2 and Nikon’s .NEF formats. Native raw fi les are encoded 
and cannot be directly modifi ed. And though they may have the same fi le extension, raw 
fi les from diff erent cameras are often programmatically diff erent from one another: a .CR2 
fi le from a 5D Mark II is diff erent than one from a 50D.

Raw fi les in your camera model’s native format must be recognized by Lightroom 
for you to work with those fi les. Adobe’s imaging software supports nearly all digital 
cameras available on the market, and support for new models is continually updated. 
However, when a new camera model is released, there may be a period of time 
during which your fi les cannot be read by Lightroom. If Lightroom can’t import 
your raw fi les, this may be the reason. Raw fi le format compatibility is addressed in 
incremental software updates to Lightroom.
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Lightroom respects XMP during import
If you’re importing raw fi les with .xmp sidecars, Lightroom will read any compatible 
metadata settings from them and the images will be added to the catalog with those 
settings applied. In the case of raw fi les that you’ve worked on but do not have sidecar 
fi les, those previous edits will not come into Lightroom unless you fi rst save that metadata 
to sidecar fi les. This is discussed further in Chapter 3.

About composite images
Any photo that is made of more than one original capture is called a composite. Without 
using additional plug-ins, Lightroom can’t produce composites. To combine multiple 
images you need to get them out of Lightroom and into other software, such as 
Photoshop. Processing individual images that will become part of a composite requires 
special consideration. If during processing you start thinking of combining multiple 
exposures—in any fashion and for any reason—you’ll need to start considering exports 
and external editors, covered in Chapter 5.

For now, as you’re looking at processing individual images in Lightroom, learn to make 
the most of the tools available. You may fi nd that in some cases—especially those that 
at fi rst glance appear to require blending exposures—can be fully accomplished in 
Lightroom. You will fi nd images that in the past may have required compositing now can 
be successfully processed with a single capture in Lightroom.

LIGHTROOM PREVIEWS
During an Import, and at other times while working in Lightroom, Lightroom reads the 
pixel data from image fi les and creates image previews, which are referenced by the 
catalog. The previews are temporary JPEG fi les created in several sizes. Lightroom renders 
new previews whenever necessary while you’re working on photos. Note that for raw fi les, 
the image data must be demosaiced and rendered to produce the preview. Pre-rendered 
fi le formats, such as JPEG and TIFF, as well as some DNG fi les, may already have preview data 
stored within them. (There’s more about these processes in Chapters 3 and 4.)

For now, you just need to know that Lightroom’s image preview fi les are stored 
outside the catalog in a separate package. When you’re working on a photo in 
Lightroom, its previews are continually updated but the actual pixel data is never altered.

A quick overview of Lightroom’s previews:

• Minimal: used for displaying thumbnails (the smallest previews).

• Standard: used for larger, single-image previews in the main preview area.

• 1:1: the largest previews in Lightroom, 1:1 refers to one screen pixel per one image 
pixel. You’ll often be looking at 1:1 previews as you zoom in to look more closely
at a photo.
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fi nd the original fi les on disk. Lightroom can’t build new previews from missing fi les, 
or fi les stored on offl  ine volumes. Previews are explained in context at various places 
throughout this book.

HOW LIGHTROOM USES PROFILES
Lightroom makes use of three main types of profi les that help create the best possible 
rendering of your photos. Camera profi les describe the color and tone characteristics of 
specifi c image sensors and processors. Lens profi les help correct for fl aws in the optical 
properties of individual camera lenses. ICC profi les describe the color reproduction of 
diff erent printers and monitors. Using the correct profi les you can be assured of the 
highest possible quality from your work in Lightroom. These are discussed at length in 
the chapters where they’re most relevant: Develop, Export, Book and Print.

LIGHTROOM PRESETS AND TEMPLATES
Throughout the program, Lightroom provides presets and templates to store settings 
and layouts. Generally speaking, presets store settings; templates store formatted layouts. 
This distinction is not critical; throughout Lightroom you’ll see frequent references 
to presets and/or templates, and the use of one term versus the other is somewhat 
inconsistent. What’s important to understand is that presets and templates can save you 
lots of time by applying previously saved settings to your photos.

The default Lightroom installation comes with many built-in presets and templates. As 
you work with Lightroom, you should also save your own as this will dramatically speed 
up your workfl ow. You can also use presets and templates made by other people; see 
the Appendix for links.

Presets folder
The Lightroom presets folder is an important folder on your hard drive that you 
may access frequently the more you use Lightroom. To get there quickly, open the 
Lightroom Preferences (under the Lightroom menu on Mac and the Edit menu on 
Windows) and on the Presets tab, click the button for Show Lightroom Presets Folder. 
We look at using presets and templates throughout the book.

Using presets and templates for batch processing
A batch is a group of fi les that are all processed using the same criteria. Lightroom gives 
you lots of ways to apply fi le-specifi c, variable data to your batch-processed photos, 
such as a unique fi le name for each one. This is mainly done using templates. When 
processing many images at one time, the choices you make become increasingly 
important. Eff ective batch processing requires planning ahead and thinking carefully 
about the correct settings.
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ABOUT LIGHTROOM PREFERENCES
In many scenarios the default Preference settings used when Lightroom is installed 
are ideal. However, when you’ve worked with Lightroom for some time, there may be 
settings you want to change to suit your computer confi guration or work habits. On a 
Mac, Lightroom’s Preferences are accessed under the Lightroom menu. On Windows, 
they’re under the Edit menu. Spend some time getting to know the options available in 
the Preferences dialog boxes; they are fairly straightforward, and with an understanding of 
Lightroom’s interface and functionality the settings you want to change will become more 
evident. In the chapters that follow, key preferences are explained in context of a particular 
aspect of the workfl ow, and there’s also more about Preferences in the Appendix.

Saving and backing up your work
As you work on your photos, Lightroom automatically saves your adjustments in the 
catalog and continually generates screen previews based on the adjustments that 
have been applied. Your original fi le (regardless of its format) remains unaltered, giving 
you unlimited fl exibility for changing your mind later. However, storing all your editing 
instructions only in the Lightroom catalog carries some risk. For example, if you do all your 
processing in Lightroom and the catalog becomes corrupted (and you haven’t made 
backups) you could lose that editing data, requiring the work to be redone. This is why you 
must get in the habit of saving your work frequently when working in Lightroom, just like 
working with any other software.

SAVE METADATA TO FILE
When you save metadata to fi les, in addition to being stored in the Lightroom catalog, 
the metadata processing instructions for the adjustments you make should also be saved 
to fi les outside the database. This can be done using sidecar fi les (for camera raw formats) 
or by saving metadata in the actual fi les themselves (for all other formats). Saving out the 
metadata helps ensure 1) your work won’t be lost and 2) your edits travel with the original 
fi le wherever it goes. Even when you save metadata adjustments into a fi le, the pixel data 
is not changed: the metadata is stored in a separate part of the fi le, and read back in when 
Lightroom (or other software compatible with XMP format metadata) loads the image. To 
Save Metadata to File, use the command on the Metadata menu or the shortcut.

BACKUP AND ARCHIVAL
Every computer user knows that backing up your fi les is critical. Still, I’d be negligent if I 
didn’t remind you to actually do it. People accidentally lose important computer data every 
day. Usually it’s because of user error (deleting something unintentionally) but equipment 
failure is also common. In the digital photography workfl ow there’s absolutely no excuse 
to risk losing all your work. I can’t over-emphasize the need for creating a practical system 
for backing up your work and updating your backups very frequently. When a hard drive 
fails mechanically or its data become corrupted, if you’re prepared, you will be back on 
track quickly. Update your backups after every work session!
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Lightroom off ers the ability to make a backup of a catalog fi le and test its integrity. 
Lightroom catalog backups are done when you exit the program; you should, at least 
occasionally, allow these backups to be performed. During a Lightroom backup, only 
the current Lightroom catalog is backed up—the image fi les are not copied.

Lightroom backup 
settings are found in the 
Catalog Settings dialog 
box. When Lightroom 
asks if you want to do a 
backup, you can specify 
the location for the 
backup fi le (see Figure 
1–6). The backups are 
automatically placed in 
subfolders named with 
the date and time.

Only keep the most recent one or two catalog backups
Go to your backups folder to periodically delete old ones.

Drag-and-drop backup
You can also back up your Lightroom catalog and previews by dragging and dropping the 
main catalog folder onto another hard disk; this is a fi ne way to do it. However, keep in mind 
this skips the data testing stage that Lightroom performs when it does its own backup.

Backing up image fi les
As is discussed repeatedly 
throughout the book, you 
should always maintain at 
least two current copies 
of each of your photo and 
video fi les on separate media 
(see Figure 1–7). The easiest 
way it to set up two hard 
drives, one as the master 
working library and the 
other as its mirror image. If 
possible, store a third backup at an alternate location. Update these backups frequently.

Syncing drives
I recommend you use backup software that can synchronize data between hard 
drives. During a sync, the fi les on each drive are compared, and only the fi les that have 
changed are copied. See the Appendix for links to recommended software.

Figure 1-6
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Figure 1-7
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Cloud backups
Depending on the size of your photo library and the frequency with which you back up 
large numbers of fi les, using cloud storage services might be a viable option. Many of 
these services allow you to create your initial backup by sending a hard drive for them to 
copy fi les to the server, which is much faster than waiting the potential weeks it might 
take to copy a large image collection over the Internet.

Removable solid state media for backups
With the recent growth in capacity, solid state (fl ash) drives, such as removable USB 
“thumb drives”, “jump drives”, etc. provide a good option for both temporary backups and 
permanent archival. With no moving parts or magnetic data, they may survive longer than 
conventional hard drives.

Essential troubleshooting
As with any software application, things can and will sometimes go wrong when you’re 
working in Lightroom. If you’re diligent about backing up your work you need not fear 
any situation Lightroom may present. Following are some general guidelines for handling 
trouble with Lightroom.

WHAT TO DO AFTER A CRASH
If Lightroom unexpectedly quits on you, or you have to force quit or restart your machine, 
you need to proceed with care the next time you launch Lightroom. While Lightroom has 
a catalog open, a “lock” fi le is placed in the catalog folder to ensure other programs on 
your computer can’t tamper with the Lightroom data. After a crash, the previous lock fi le 
may remain, and you may also see a Journal fi le. Do not delete these fi les! Lightroom 
will use them to help restore the previous work session when the program is restarted.

Also, in these situations, there is the possibility of catalog corruption. If Lightroom tells you the 
catalog is corrupt and needs to be repaired, let it proceed. After a successful repair, optimize 
and back up the catalog. If the repair is unsuccessful, or the catalog is acting quirky, you may 
need to restore a previous catalog backup to use as your new master working catalog. See 
Chapter 11 for more information about recovering corrupted catalogs.

Avoid force-quitting Lightroom whenever possible
If you experience what appears to be a crash in Lightroom, especially if you can still move 
the cursor, give it a few minutes to see if the application and/or operating system recover 
from the condition. Force-quitting Lightroom at any time and for any reason dramatically 
increases the likelihood of data corruption. Of course, sometimes force-quitting can’t be 
helped… keep good backups!

MISSING FILES AND PREVIEWS
If you open a Lightroom catalog and previews for your photos aren’t visible, it’s usually 
because those fi les cannot be found by Lightroom. If they are on an external drive, check 
that it’s connected. In Chapter 3 you can learn about dealing with missing fi les.
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01The Lightroom Workspace
When you launch Lightroom, the main window opens with the same settings and 
image selections that were in use when you last quit the program (see Figure 1–8). 
Following is an overview of the Lightroom screen layout, tools and controls. The specifi c 
operation of these are detailed in the chapters that follow.

MAIN APPLICATION WINDOW
Lightroom’s main window opens when you launch the program. This is where you’ll do most 
of your work. The appearance of the main application window is highly customizable.

Screen Modes
The main Lightroom application window has three screen modes:

Standard: a fl oating, resizable window. May or may not fi ll your entire screen. Resize 
the window by clicking and dragging its sides or corners. Move the window by clicking 
and dragging the title bar at the top.

Full Screen with Menubar: fi lls your screen with the Lightroom application window. 
This window is not resizable.

Full Screen: like the above, but the main menu bar at the top of the screen is hidden. 

Figure 1-8
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(On Windows, the Taskbar is hidden as well; this is my preferred screen mode.) As needed, 
put your mouse cursor at the top of the screen to access the menu bar. When you’re 
fi nished, move away from the menu bar and it becomes hidden again.

Lights Out
Lights Out dims or hides all the interface elements to show only the photo previews (see 
Figure 1–9). If no photographs are selected, all the thumbnails will remain visible in Lights 
Out. If one or more photos are selected, those will remain visible while the unselected 
photos will be hidden. There are three Lights Out modes:

• Lights On: this is the default state, where all interface elements and photographs are 
shown at full strength.

• Lights Dim: the interface is dimmed (by a percentage you can set in Lightroom 
Preferences).

• Lights Out: all interface elements are hidden by a solid color (also specifi ed in 
Preferences).

Lightroom Interface Preferences
Many of Lightroom’s interface options can also be customized in the Lightroom 
Preferences (under the Lightroom menu on Mac and the Edit menu on Windows.)

L
Cycle
Lights Out

Figure 1-9
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01SECONDARY DISPLAY
Lightroom off ers support for dual monitors using the Secondary Display feature (see 
Figure 1–10). Open the second window by clicking the button on the upper left side of the 
Filmstrip. The Secondary Display is a pared-down version of the main window and has its 
own layout and controls. (You can also play slideshows in the second window; see Chapter 
8.) You can open the Secondary Display window even with only one monitor.

MODULES
All work in Lightroom is done in one of seven modules. The modules provide tools and 
commands specifi c to each phase of the workfl ow. The modules can be accessed using 
the Module Picker (to the right of the top panel (see Figure 1–11) or by using various 
keyboard shortcuts.

Figure 1-10

Figure 1-11
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Library 
This is where you organize, sort and manage your images. Library is also where you edit 
video in Lightroom 4. A limited subset of processing controls is provided in the Quick 
Develop panel. See Chapter 3 for more information about Library.

Develop
Here you can process your photos to perfection. Cropping and straightening, tone and 
color adjustments, noise reduction, sharpening, creative eff ects… the list goes on and on. 
The Develop module is the core of Lightroom’s image processing power; see Chapter 4.

Map
Using the all-new Map module you can view the locations where your photos were taken. 
You can use the Map module to add and edit location data as well as integrating GPS data 
using tracklogs. See Chapter 6.

Book
Also brand new in Lightroom 4, the Book module allows you to create sophisticated book 
designs and upload them directly to Blurb and/or output them as PDF fi les. See Chapter 7.

Slideshow 
In the Slideshow module you can design presentations for playback within Lightroom or 
exporting as video, PDF or JPEG fi les. See Chapter 8 for information about working in Slideshow.

Print
Lightroom’s Print module gives 
you a variety of tools to create 
custom layouts and make high 
quality prints. See Chapter 9.

Web
In Lightroom’s Web module, 
generating Web galleries in HTML 
or Flash format is quick and 
easy. See Chapter 10.

Module Tips
New in Lightroom 4: each 
module has its own set of Tips (see Figure 1–12). You’ll see them the fi rst time you enter each 
module under a new installation of Lightroom 4, and then they go away. To see Module Tips at 
any time, use the command under the Help menu.

Delays when switching between modules
There are times when Lightroom’s performance slows or seems to stall. Often this happens 
when switching between modules or tools; this is especially true with the new Map and 
Book modules. In most cases, it’s best to wait (stop clicking!!) and let Lightroom fi nish 
the current process. You will often fi nd that—even when Lightroom appears to have 

Figure 1-12
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01crashed—if you give it a few moments, the program will recover, fi nish processing
and resume normal operation.

MAIN PREVIEW AREA
In Library and Develop, photos are shown in the center of the Lightroom window (see 
Figure 1–13). In the output modules this area is used to preview the current layout. The 
size of the preview area is variable, based on the visibility and sizes of the panels.

Preview background options
Right-click or Ctrl+click in the main preview 
background to change color and texture options 
(see Figure 1–14).

PANELS
Around the main preview area, the Lightroom 
application window is divided into four panels 
(see Figure 1–8). Lightroom’s panels contain the 
majority of controls you will use to process your 
photos. Note that panels can’t be “undocked”, 
moved or fl oated in the main window; they are 
always in the same position. However, they can be hidden and resized as described 
below. The contents of the left and right panels change within each module. 

Figure 1-13

Figure 1-14
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Show/Hide 
all panels

05_9781118206171_ch01.indd   2705_9781118206171_ch01.indd   27 3/16/12   4:06 PM3/16/12   4:06 PM



28

01

LIGHTROOM 4: STREAMLINING YOUR DIGITAL PHOTOGRAPHY PROCESS

Generally, left panels are used for organizing, batch processing and accessing presets and 
templates, while right panels contain tools used for applying specifi c settings to photos 
or output layouts. The top panel (Module Picker) and bottom panel (Filmstrip) remain 
consistent throughout all the modules.

TOP PANEL
The top panel contains the Identity Plate (left) and the Module Picker (right). During 
processing, Lightroom’s progress indicators are also displayed in the Identity Plate area.

Identity Plates
At the far left of the top panel is the main Identity Plate (see Figure 1–15.). You can customize 
it with your own text or graphic fi les. The main identity plate can be used in slideshows, Web 
galleries and print layouts, and in those modules you can also create additional identity plates.

Apply a custom identity plate
Use the menu command under Lightroom menu➔Identity Plate Setup (Mac) or Edit…
➔Identity Plate Setup (Windows) to customize and save identity plate presets using the 
main Identity Plate Editor (see Figure 1–16). Also see Chapters 8, 9 and 10 for more about 
using Identity Plates in the output modules.

To turn off  the custom identity plate, simply uncheck the box in the Identity Plate Editor.

Figure 1-15

Figure 1-16
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and multithreading
When Lightroom is working 
on a process, the main Identity 
Plate is replaced with the Activity 
Viewer, which shows one or more 
progress bars (see Figure 1–17). 
Lightroom is multithreaded, which 
means it can multitask: several 
operations can be performed at 
the same time. If more than one 
process is going, multiple progress 
bars are shown.

Stopping a process
To stop a process, click the small 
X at the right side of the progress bar.

Move on to other tasks
There is usually no need to wait for a 
process to complete before moving on 
to another task. For example, if you are 
in the middle of an import, you can still 
work on images already in the Library. 
If you’re exporting a Web gallery, a 
batch of images, etc., the same applies.

The new Module Picker
New in Lightroom 4: right-click or Ctrl+click on a module name in the top panel. From the 
popup menu, you can hide and show individual modules from the list (see Figure 1–18).

LEFT AND RIGHT PANELS
The contents of the panels are diff erent for each module. Generally, the left panels 
provide access to fi les and templates within each module. The right panels in Library 
and Develop include tools for modifying the photo(s). In the output modules, the right 
panels contain controls for changing layout settings.

Hiding and showing panel groups
The combined assemblages of the left and right module panels are typically referred 
to as panel groups (or panel sets). To hide a panel group, click its outer edge. Click again 
to show it. Or, when a panel group is hidden, you can temporarily show it by hovering 
your mouse cursor over the collapsed panel at the outer edge of the window. This is 
called Auto Hide/Show, and can be enabled or disabled. Auto Hide/Show allows you to 
temporarily access the panel group to make whatever changes are necessary, and when 
you move the cursor away, the panel group is hidden again. Right-click or Ctrl+click a 

Figure 1-17

Figure 1-18
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panel edge to set options for Auto Hide/Show 
and syncing between opposite panels (see 
Figure 1–19).

Panel states for each module persist until 
you change them.

Change panel size
Panels can be resized by dragging their edges. 
Wider panels shows longer fi le and template 
names and provides greater sensitivity for 
adjustment sliders. Narrower panels make 
more room for photos in the preview area. To 
change the width of a panel group, position 
your mouse cursor over the inside edge of any 
panel; the mouse cursor changes to a double 
arrow (see Figure 1–20). Click and drag to 
resize the panel. Note that all panels have a 
minimum and maximum width.

Show the panels you use; hide the others
I usually work with diff erent panel groups 
hidden in each module. For example, in Library, 
I prefer to keep the right panel hidden and 
the left panel showing. This is because the left 
panel provides access to fi les in Folders and 
Collections, which I use a lot. I less frequently 
use the Library right panel to make metadata 
edits to fi les (mostly keywords). Conversely, in the Develop module, I usually work with the left 
panel hidden and the right panel showing, because the tools I use most often are in the right 
panel. (I may temporarily auto-show the left panel to apply Develop presets.)

Expand and collapse individual panels
In addition to hiding and showing the entire 
left and right panel groups, individual panels 
can be expanded and contracted (see Figure 
1–21). Click anywhere in the top bar of each 
panel to hide or show its contents (it’s not 
necessary to click directly on the triangle).

Expand All and Collapse All
Right-click or Ctrl+click on the panel header 
and select Expand All or Collapse All to open 
or close all the panels in the group.

Figure 1-19

Figure 1-20

Figure 1-21
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The individual panels in the left and right panel 
groups can be removed and restored from 
the main panel track as you see fi t. Right-click 
or Ctrl+click on a panel header, then make 
selections from the contextual menu to show or 
hide individual panels or select Hide All/Show All 
(see Figure 1–22). Note: the Navigator, Preview 
and Histogram panels cannot be hidden.

Solo Mode
When you enable Solo Mode, opening one panel 
closes all the others. This is my preferred way of 
working, except in the Library left panels, where 
it’s often advantageous to have Folders and 
Collections open at the same time.

Right-click or Ctrl+click on any of the panel 
headers; select the option from the popup menu 
to enable Solo Mode (see Figure 1–23). The Triangle 
icon on the panel header changes to a dotted 
pattern to indicate Solo Mode is active.

Option+click or Alt+click on any panel header to open 
that panel and simultaneously toggle Solo Mode.

Shift+click on a panel header to open it without 
closing the previous one.

NAVIGATOR PANEL
The Navigator (see Figure 1–24) is in the fi rst 
position of the left panel group in the Library and 
Develop modules (this panel is replaced with 
Preview in the output modules, where it functions a bit diff erently). The Navigator shows 
a preview of the selected photo, or the target photo if multiple photos are selected. The 
Navigator panel can be used to select zoom levels, or ratios of magnifi cation. Selecting a 
zoom level in the Navigator enlarges the photo preview to that size.

Zoom Ratios
Unlike other programs that specify magnifi cation level with a percentage, Lightroom’s 
zoom levels are based on the ratio of image pixels to screen pixels. 1:2 is one screen 
pixel to two image pixels. 4:1 is four screen pixels to one image pixel, and so on.

The preset zoom ratios are:

• Fit: fi ts the entire photo into the main preview area.

Figure 1-22

Figure 1-23
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• Fill: fi lls the preview area top-to-bottom with the image. The sides of images
may not be visible.

• 1:1: one image pixel for one screen pixel.

• User-selected setting: the 
fourth zoom ratio setting uses 
the last custom zoom level you 
selected. Clicking this ratio will 
also display a popup menu 
for you to choose the custom 
zoom level (see Figure 1–24).

New in Lightroom 4: there are 
two new zoom ratios—1:8 and 1:16. 
(These are useful for Soft Proofi ng in 
the Develop module; see Chapter 4.)

Move around an enlarged 
preview with the Navigator
When zoomed in to a photo, drag 
the white box in the Navigator 
preview to change the area shown in 
the main preview (see Figure 1–24).

Preview presets in Navigator
The Navigator off ers more than just a preview. For instance, in Library, moving your mouse over 
folders or collections will show the fi rst image in that source in the Navigator. And in Develop, 
Navigator shows previews of presets. Just roll your mouse cursor over the presets in the list, and 
Navigator will show you what that preset looks like applied to the selected image.

FILMSTRIP (BOTTOM PANEL)
The bottom panel, called the Filmstrip, shows thumbnails for the images in the current 
image source (see Figure 1–25). The Filmstrip remains the same throughout all the 
modules. You can change the order of photos in the Filmstrip and the display of the 
thumbnails. There’s more about this in Chapter 3.

Figure 1-24

Figure 1-25
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At the left of the top part of the Filmstrip are navigation controls. The square icon is a 
shortcut to Library Grid view mode; next to that are arrows to go forward and back.

Change the size of Filmstrip thumbnails
Drag the top edge of the Filmstrip to resize it; this changes the size of the thumbnails.

Double click to toggle size
When you’ve resized the Filmstrip,
you can double click the top of it to 
toggle between the two most recently 
used sizes.

PANEL CONTROLS
Within the panels, Lightroom provides 
several types of software controls to edit 
and process your photos. Most can be 
manipulated using either your mouse or 
the keyboard. Some require you to select 
from a menu; others let you type directly 
into text boxes.

Disclosure triangle buttons
Throughout Lightroom’s panels there
are very small and easily overlooked 
black triangle-shaped buttons (see Figure 
1–26). These open and close a subsection 
of the panel, revealing or hiding more 
controls.

Arrow buttons
These are found on the Quick Develop 
panel (see Figure 1–26). While most 
of Lightroom’s settings are absolute 
(applying a specifi c value), the arrow 
button controls are relative—they are 
applied on top of whatever settings are 
already present. The single arrow buttons 
apply changes in smaller increments 
than the double arrows. See Chapter 3 for 
more about Quick Develop.

Sliders
Particularly in Develop, the sliders (see 
Figure 1–27) are the most common 

Figure 1-26

Figure 1-27
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method of making adjustments to photos. Lightroom’s sliders can be adjusted
in several ways:

• Drag the slider with your cursor.

• “Scrub” the slider’s numeric value left and right using the mouse.

• Position your cursor anywhere over the slider and then use the up and down
arrow keys to increase or decrease the value.

• Double-click a slider to Reset it to its default value.

• Double-click the fi eld and type in a numeric value.

Text entry fi elds
There are text fi elds in many panels throughout the modules. To enter text, click on the 
fi eld and type. Always be sure to press Enter or Return when you’re done typing text into 
a fi eld anywhere in Lightroom. This reduces the chance of accidentally typing something 
into a text box when you’re trying to use a shortcut. If you change your mind typing into a 
text or dialog box, or to deactivate a tool, press Esc to cancel.

Tooltips
Place your cursor over part of the interface and let it remain for a few seconds (without moving 
or clicking) to see a popup tooltip telling you what that control does. If there is a keyboard 
shortcut for the tool or command, it will also be shown in the tooltip (see Figure 1–26).

Panel switches
Most panels that provide 
controls for image 
adjustments (and Filmstrip 
fi lters) provide a small “switch” 
that allows you to disable/
enable the adjustments for 
that panel. Like a light switch, 
up is “on” and down is “off ” (see 
Figure 1–28). Look for these 
switches in numerous places 
throughout Lightroom’s 
interface. In some cases, they 
may be oriented left/right. In all cases, they perform the same function: enabling and 
disabling the eff ects of that panel or control.

Figure 1-28
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When multiple left and right panels are 
open, their contents will often be too long 
for all the panels to show on the screen. In 
this event, scroll bars appear to allow you to 
move up and down within the panel track 
(see Figure 1–29). Click and drag the bar to 
scroll, or use your mouse wheel.

Panel End Marks
The panel end mark ornaments at the 
bottoms of the left and right panel groups 
(see Figure 1–30) are designed to let you 
know there are no more panels below. You 
can change the graphic used for the panel 
end marks, you can add your own, or you 
can remove them completely. Once you 
get used to the panels, these end marks 
become unnecessary. I prefer to leave them 
hidden to reduce screen clutter. Right-click 
or Ctrl+click on or around the end mark and 
select a panel end mark from the list.

Custom panel end marks
From the panel contextual menu,
select Go to Panel End Marks 
Folder. You can fi nd custom 
panel end marks on the Web, or 
create your own in Photoshop. 
Put the image fi les in the folder 
and restart Lightroom; your 
custom fi les will then show in 
the list.

MENUS, COMMANDS 
AND SHORTCUTS
Lightroom’s main menu bar 
changes from one module to 
the next. In this way, Lightroom 
is like seven programs in one! 
To memorize all the commands 
available in Lightroom requires 
using and remembering all 
the diff erent menus in each 
module. (However, there are some shared menus and commands that remain constant 
throughout the modules.) As you’re learning to use Lightroom, frequently look at the 

Figure 1-29

Figure 1-30
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menus, commands and 
shortcuts available in each 
module. This will not only 
give you a better grasp 
of the full functionality 
available in Lightroom, 
it will speed your work 
as you memorize the 
locations and shortcuts 
for specifi c commands. As 
with Lightroom’s menus, 
each module has its own 
shortcuts, and some 
shortcuts in diff erent 
modules share the same 
key. Shortcuts are shown 
next to the corresponding 
commands in menus (see 
Figure 1–31).

Many shortcuts are toggles
In Lightroom, many of the keyboard shortcuts 
turn tools on and off  or make items active/
inactive. This is a toggle control.

Contextual Menus
Lightroom is full of contextual menus (see Figure 
1–32). Using them is essential to speeding up 
your work. A contextual menu’s contents are 
determined by the context in which you clicked. 
Depending on where you click, contextual 
menus appear showing the commands most 
useful and appropriate for the object clicked. 
Though this book provides many keyboard 
shortcuts, I use contextual menus as much or 
more than the keyboard. I work with a tablet and 
stylus, and a right-click or Ctrl+click is often faster 
than switching to the keyboard.

Figure 1-31

Figure 1-32
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Each module has its own Toolbar containing various tools for that module (see Figure 
1–33). The Toolbar is shown at the bottom of the main preview area and can be hidden 
and shown. Most of the tools and functions on the Toolbar can also be performed using 
shortcuts; once these are committed to memory, it’s possible to work most of the time 
with the Toolbar not showing.

Change what shows in the Toolbar
At the right side of the Toolbar is a button that activates a menu that you can use to 
customize the contents of the Toolbar specifi c to each module (see Figure 1–33). The 
Toolbars for each module are described in those chapters.

WORKSPACE QUIRKS
Many of Lightroom’s interface widgets are very small and—using various shades of gray, 
black and white—can be easily missed. Get in the habit of looking very closely at the 
Lightroom interface to discover the full set of controls.

Option or Alt
In many areas of Lightroom’s interface, holding the Option or Alt key reveals additional 
functions, such as hidden controls, buttons and options. For example, the Quick 
Develop panel in Library shows additional controls when Option or Alt is held down. 
The Sharpening panel in Develop has uses for Option/Alt. And, holding Option/Alt 
changes the Export button to Export Catalog. Memorize the most important places the 
Option/Alt key is useful, then as you’re working, periodically press the key and watch 
how it changes the options on the screen. Many otherwise hidden functions become 
readily available.

Figure 1-33
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Hide-and-seek interface widgets
Throughout Lightroom there are controls that will only show if they are relevant to
the selected photo or photos. In cases where these controls don’t apply, they are
hidden from view.

How to ensure accurate color for your photos
Color management refers to an integrated system of computer hardware and software 
working together to translate color from one device to another in a controlled way. For 
your photos to look their best, implementing color management is a critical aspect of 
successfully going from capture to print with the best possible quality.

The color management system (CMS) is built into your computer’s operating system—on 
Mac it’s ColorSync and on Windows Vista and 7 it’s WCS. The CMS handles color management 
at the system level and is responsible for translating color values to and from your image 
fi les and output devices. Lightroom is color-managed by default and there are no color 
settings to confi gure. (Lightroom uses a 16-bit, proprietary color space for internal 
processing.)

CALIBRATING AND PROFILING YOUR DISPLAY
The most important step in achieving accurate color in your photos is working on a 
calibrated and profi led display. If you’re using a properly calibrated and profi led display, 
you can trust that the colors you see on-screen in Lightroom are accurate.

Calibrating your display corrects its output settings. Profi ling makes an ICC profi le for use 
by the CMS. Calibrating and profi ling your display must be done with a combination 
of dedicated hardware and software. Software alone, (such as Adobe Gamma) is not 
suffi  cient. You must use a dedicated measurement device for accurate calibration. I 
use and recommend the X-Rite i1 (Eye One) and Color Munki systems for this; see the 
Appendix for links.

USING COLOR PROFILES
A color profi le describes a color space—the range of available colors and their numeric 
values. Profi les can be embedded in image fi les. The embedded profi le tells the color 
management system the parameters for translating the photo’s colors to diff erent 
devices—printer, monitor, etc. When Lightroom generates new fi les, profi les are always 
embedded by default. The Print and Book modules allow you to choose the color profi les 
to be used, as does the Export window. To ensure consistent color, whenever you’re saving 
fi les out of Lightroom, you should always use the correct color profi les for the intended 
use. See Chapters 4, 5, 7 and 9 for more about working with color profi les.

Lightroom always respects and preserves profi les embedded in imported image fi les. For 
fi les with no embedded profi le, sRGB is used. Video fi les do not have embedded profi les 
and thus cannot be color managed.
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01Next steps
Now that you’ve got a solid foundation in how Lightroom works, let’s jump right 
in and Import some photos! Chapter 2 describes how you can import photos from 
your hard drive and from a camera or memory card.

Process in Lightroom, not in-camera
Though many current camera models off er varying levels of processing within the 
camera itself (brightness, contrast, color and sharpness controls, black and white 
conversion, etc.) it’s almost always best to do the image processing in Lightroom, 
not in the camera.

Consider post-processing while you are shooting
Once you’re comfortable quickly changing settings on your camera while shooting, 
start to consider how you will process the fi le later. Taking production issues into 
account while you’re shooting will help you get better captures and make post-
processing easier.
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